
 AN2602
 Migrating from ATmega48/88/168 to ATmega48PB/88PB/

168PB

Features

The ATmega48PB/88PB/168PB introduces several new features:

• picoPower® features
• Four extra GPIO pins

– One pair of GND and VCC removed and replaced with two extra GPIO pins
– Two pins that previously only had ADC input channels are now multiplexed with GPIO

• USART Start Frame Detection available in all sleep modes
• Analog Comparator output to pin added
• Serial number (Unique Device ID) added

Introduction

This application note acts as a guide to help users of ATmega48/88/168 migrating to the newer
ATmega48PB/88PB/168PB.

ATmega48PB/88PB/168PB is functionally compatible with ATmega48/88/168. This document will
describe how to update the toolchain, developer tools, and IDE.

Always check the latest revision of the corresponding data sheet for the latest and correct characteristics
and device details. It is recommended to review the Errata list.

The latest data sheets can be found here:

• ATmega48/88/168 - http://www.microchip.com/wwwproducts/en/ATmega168
• ATmega48PB/88PB/168PB - http://www.microchip.com/wwwproducts/en/ATmega168pb
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1. Hardware Design Compatibility

1.1 Package Types
ATmega48PB/88PB/168PB can function as a drop-in replacement for the 32-pin TQFP package, and the
32-pin VFQFN with the 32-pin MLF package, but there are conditions to follow. See chapter Added/
Modified Pin Functionality. For other package types, expect to change the PCB layout when migrating
from ATmega48/88/168 to ATmega48PB/88PB/168PB. The data sheet includes dimensions and physical
drawings of the footprint for each device under "Packaging Information". Below are the different package
types compared to the different devices.

ATmega48/88/168 is available in the following package types:
• 32-pin TQFP
• 32-pin MLF
• 28-pin VQFN
• 28-pin PDIP

ATmega48PB/88PB/168PB is available in two package types:
• 32-pin TQFP
• 32-pin VFQFN

1.2 Added/Modified Pin Functionality
There are two package types that are compatible with ATmega48/88/168 and ATmega48PB/88PB/
168PB. This section will compare the pin-out of the TQFP package type. For the other compatible
package type, MLF/VFQFN, refer to the data sheet chapters "Ordering Information" and "Packaging
Information".

ATmega48PB/88PB/168PB introduces four additional GPIO pins; PORTE [3:0]. The different pins are
described in Table 1-1 and the pin-out for each device are shown in Figure 1-1 and Figure 1-2.

The 32-pin MLF/VQFN pin-out can be found in the Pin Configurations section in the ATmega48PB/88PB/
168PB data sheet.
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Figure 1-1.  ATmega48/88/168 - 32-Pin TQFP
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Figure 1-2.  ATmega48PB/88PB/168PB - 32-Pin TQFP
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GPIO pins PE2 and PE3 are added to Pin19 and Pin22. PE2 and PE3 are multiplexed with ADC6 and
ADC7.

Pin3 (GND) and Pin6 (VCC) are replaced by PE0 and PE1 respectively. PE0 is multiplexed with ACO.
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Table 1-1. Pin Functionality Difference

32-Pin TQFP Package ATmega48/88/168 ATmega48PB/88PB/168PB

Pin3 GND PE0/ACO

Pin6 VCC PE1

Pin19 ADC6 ADC6/PE2

Pin22 ADC7 ADC7/PE3

CAUTION To use the ATmega48PB/88PB/168PB device as a drop-in replacement for the
ATmega48/88/168 the following conditions must meet:

• Pin 3 - If connected to GND, the pin must not be actively driven or ACO must not be
enabled.

• Pin 6 - If connected to VCC, the pin must not be actively driven.

1.3 Alternate Pin Configuration
The alternate pin configurations are:

• ADC7– Port E, Bit 3
PE3 can also be used as ADC input channel 7. ADC input channel 7 uses analog power AVCC.

• ADC6 – Port E, Bit 2
PE2 can also be used as ADC input channel 6. ADC input channel 6 uses analog power AVCC.

• None – Port E, Bit 1
No alternate function.

• ACO – Port E, Bit 0
ACO Analog Compare Output pin is multiplexed with PE0.
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2. Code Compatibility
ATmega48/88/168 is code compatible with ATmega48PB/88PB/168PB.

To ensure that code designed for ATmega48/88/168 executes on the ATmega48PB/88PB/168PB the user
must remember to change the device and recompile the code.

A general rule of thumb is that reserved bits should be written to zero if accessed. Reserved I/O memory
addresses should never be written.

2.1 Writing Reserved Registers
If code should by accident write to a reserved register, Microchip can not guarantee the behavior of the
application.

This chapter describes what to be aware of when using code designed for the ATmega48/88/168 on the
ATmega48PB/88PB/168PB. If by mistake, the code accesses reserved registers or bit locations, the
previous device might still operate as expected. On the newer devices these registers or bits might have
specific functions, hence unexpected behavior can be observed.

On the ATmega48/88/168 register location 0x4F is reserved as shown in figure Figure 2-1.

Figure 2-1. Extract From the ATmega48/88/168 Data Sheet

On the ATmega48PB/88PB/168PB register location 0x4F is the ACSR0 register. This register contains
one bit that controls the analog comparator output to Pin 3, ACOE - Analog Comparator Output Enable,
as shown in figure Figure 2-2.

Figure 2-2. Extract From the ATmega48PB/88PB/168PB Data Sheet

If the ACO is enabled by accident, and ATmega48PB/88PB/168PB is used as a drop-in replacement for
ATmega48/88/168, the ACO can potentially try to drive a pin which is connected to GND, and this can
lead to unexpected behavior.

2.2 Device Part Pack
To ensure full device support for ATmega48PB/88PB/168PB the latest part pack must be installed. Up-to-
date part packs are included in the latest version of Atmel Studio 7.0, or can be manually downloaded if
needed:

• In the Atmel Studio 7.0 toolbar, click Tools -> Device Pack Manager. In the Device Pack Manager
window click and select the latest version under ATmega_DFP, then click Install -> Install Selected
Packs.

• [Alternative] Go to http://packs.download.atmel.com/ and download the latest Atmel ATmega Series
Device Support. Install the downloaded file.
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3. Ecosystem
The ecosystem for AVR® products includes Atmel Studio 7 Integrated Development Environment,
Toolchains for AVR, Programmers, Debuggers, and Starter Kits.

3.1 Integrated Development Environment

3.1.1 Atmel Studio 7
ATmega48PB/88PB/168PB is supported in the latest version of Atmel Studio 7 - a Free IDE for
development of C/C++ and assembler code for Atmel microcontrollers.

Studio 4 does not support ATmega48PB/88PB/168PB.

Go to http://www.microchip.com/development-tools/atmel-studio-7 for the latest installer and user guide,
and other relevant information.

3.1.2 IAR
ATmega48PB/88PB/168PB is supported in IAR Embedded Workbench® for Atmel AVR® - a commercial
C/C++ compiler that is available for 8-bit AVR. Users of IAR™ must ensure their current installed version
supports ATmega48PB/88PB/168PB.

There is a 30-day evaluation version as well as a 4 KB code size limited kick-start version available from
their website: https://www.iar.com/iar-embedded-workbench/partners/atmel/

3.2 Development Tools
The following developer tool is recommended for ATmega48PB/88PB/168PB:

• Atmel-ICE

Other legacy tools that also support ATmega48PB/88PB/168PB:
• AVR Dragon
• AVR One!
• AVRISP mkII
• JTAGICE mkII
• JTAGICE3
• Power Debugger
• QT600
• STK500
• STK600
• Simulator
• mEDBG

To update the desired tool in Atmel Studio 7: Click Tools → Device Programming in the Atmel Studio 7
Toolbar. When device programming has opened, choose the desired tool, device and interface, and then
click Apply. If the tool has an older firmware version, Atmel Studio will prompt you to update the tool
firmware version.

 AN2602
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Another method: In the Atmel Studio toolbar, click View → Available Atmel Tools. In the Available Atmel
Tools window right-click on your Tool and choose Upgrade... in the drop-down menu.
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4. New Features
This chapter summarizes the enhancements or added features in ATmega48PB/88PB/168PB compared
with ATmega48/88/168.

• USART Start Frame Detection is available in all sleep modes
• Analog Comparator output is available on a pin. (This pin is multiplexed with PE0.)
• Serial Number (Unique Device ID)
• picoPower
• ADC Temperature Measurement

4.1 USART
The USART Start Frame Detector can wake up ATmega48PB/88PB/168PB from all sleep modes when it
detects a start bit.

When a high-to-low transition is detected on RxDn, the internal 8 MHz oscillator is powered up and the
USART clock is enabled. After start-up, the rest of the data frame can be received, provided that the baud
rate is slow enough in relation to the internal 8 MHz oscillator start-up time. Start-up time of the internal 8
MHz oscillator varies with supply voltage and temperature.

The USART start frame detection works in both asynchronous and synchronous modes. It is enabled by
writing the Start Frame Detection Enable bit (SFDE). If the USART Start Interrupt Enable (RXSIE) bit is
set, the USART Receive Start Interrupt is generated immediately when start is detected.

When using the feature without start interrupt, the start detection logic activates the internal 8 MHz
oscillator and the USART clock while the frame is being received, only. Other clocks remain stopped until
the Receive Complete Interrupt wakes up the MCU.

The maximum baud rate in synchronous mode depends on the sleep mode the device is woken up from:

• Idle sleep mode: system clock frequency divided by four
• Standby or Power-down: 500 kbps

The maximum baud rate in asynchronous mode depends on the sleep mode the device is woken up
from:

• Idle sleep mode: the same as in active mode
Table 4-1. Maximum Total Baud Rate Error in Normal Speed Mode

Baud Rate Frame Size

5 6 7 8 9 10

0 - 28.8 kbps +6.67
-5.88

+5.79
-5.08

+5.11
-4.48

+4.58
-4.00

+4.14
-3.61

+3.78
-3.30

38.4 kbps +6.63
-5.88

+5.75
-5.08

+5.08
-4.48

+4.55
-4.00

+4.12
-3.61

+3.76
-3.30

57.6 kbps +6.10
-5.88

+5.30
-5.08

+4.69
-4.48

+4.20
-4.00

+3.80
-3.61

+3.47
-3.30

 AN2602
New Features

© 2017 Microchip Technology Inc.  Application Note DS-00002602A-page 10



Baud Rate Frame Size

5 6 7 8 9 10

76.8 kbps +5.59
-5.88

+4.85
-5.08

+4.29
-4.48

+3.85
-4.00

+3.48
-3.61

+3.18
-3.30

115.2 kbps +4.57
-5.88

+3.97
-5.08

+3.51
-4.48

+3.15
-4.00

+2.86
-3.61

+2.61
-3.30

Table 4-2. Maximum Total Baud Rate Error in Double Speed Mode

Baud Rate Frame Size

5 6 7 8 9 10

0 - 57.6 kbps +5.66
-4.00

+4.92
-3.45

+4.35
-3.03

+3.90
-2.70

+3.53
-2.44

+3.23
-2.22

76.8 kbps +5.59
-4.00

+4.85
-3.45

+4.29
-3.03

+3.85
-2.70

+3.48
-2.44

+3.18
-2.22

115.2 kbps +4.57
-4.00

+3.97
-3.45

+3.51
-3.03

+3.15
-2.70

+2.86
-2.44

+2.61
-2.22

4.2 Analog Comparator
The Analog Comparator Output (ACO) can be connected to PE0 if the Analog Comparator Output Enable
(ACOE) is written with "1" in the Analog Comparator Control and Status Register C (ACSR0).

4.3 Serial Number
Each ATmega48PB/88PB/168PB has an integrated serial number (also called unique device ID) that can
be used to uniquely identify each part.

There are two approaches to get the serial number information.

One way is to read the Signature Row from software. For detailed information, refer to section "Reading
the Signature Row from Software" in the latest data sheet.

Table 4-3. Signature Row Addressing

Signature Byte Z-Pointer Address

Device Signature Byte 1 0x0000

Device Signature Byte 2 0x0002

Device Signature Byte 3 0x0004

RC Oscillator Calibration Byte 0x0001

Serial Number Byte 1 0x000E

Serial Number Byte 0 0x000F

Serial Number Byte 3 0x0010
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Signature Byte Z-Pointer Address

Serial Number Byte 2 0x0011

Serial Number Byte 5 0x0012

Serial Number Byte 4 0x0013

Serial Number Byte 6 0x0015

Serial Number Byte 7 0x0016

Serial Number Byte 8 0x0017

Note: 
If the serial number feature is used across several device families the device signature bytes should also
be included in the serial number. Extending the serial number to a 12-byte number.

Another way is to read I/O address 0xF0 - 0xF8, as the ATmega48PB/88PB/168PB serial number can be
accessed through I/O registers SNOBRx. The serial number is made from concatenating the nine bytes
read out from these read-only registers. See sub-chapter SNOBRx - Serial Number Byte 8 to 0 for more
detail.

An example of how to read out the serial number is given below:

C Code Example

uint8_t serial_num[9] = {0};

for(uint8_t i = 0; i < 9; i++){
    serial_num[i] = *((uint8_t *) &DEVID0+i);
}

4.3.1 SNOBRx - Serial Number Byte 8 to 0

(0xF8)

(0xF7)

(0xF1)

(0xF0)

(0xF3)

(0xF2)

(0xF5)

(0xF4)

(0xF6)

Serial Number Byte 5

Serial Number Byte 4

Serial Number Byte 3

Serial Number Byte 2

Serial Number Byte 1

Serial Number Byte 0

Serial Number Byte 6

Serial Number Byte 7

Serial Number Byte 8

SNOBR5

SNOBR4

SNOBR3

SNOBR2

SNOBR1

SNOBR0

SNOBR6

SNOBR7

SNOBR8

R R R R R R R R

7 6 5 4 3 2 1 0

Read/Write

Initial Value Serial Number Byte Value
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4.4 picoPower/Power Management and Sleep Modes
The essence of an AVR® picoPower device goes beyond merely the various picoPower features included.
The design methodology, the process geometry, and even the types of transistors used are all essential
power-saving parts of a picoPower device. All picoPower devices are designed from the ground up for
low power consumption utilizing AVR’s proprietary low leakage processes and libraries to provide industry
leading low power consumption in active and all sleep modes.

The white paper "Innovative Techniques for Extremely Low Power Consumption with 8-bit
Microcontrollers" and the application note "AVR4013-picoPower Basics" give a more in-depth look at the
picoPower features.

4.4.1 BOD Disable
When the Brown-out Detector (BOD) is enabled by BODLEVEL fuses, the BOD is actively monitoring the
power supply voltage during a sleep period. To save power, it is possible to disable the BOD by use of
software for some of the sleep modes. The sleep mode power consumption will then be at the same level
as when BOD is globally disabled by fuses. If BOD is disabled in software, the BOD function is turned off
immediately after entering the sleep mode. Upon wake-up from sleep, BOD is automatically enabled
again. This ensures safe operation in case the VCC level has dropped during the sleep period.

When the BOD has been disabled, the wake-up time from sleep mode will be approximately 60 μs to
ensure that the BOD is working correctly before the MCU continues executing code.

BOD disable is controlled by the BOD Sleep bit in the MCU Control Register (MCUCR.BODS). Writing
this bit to '1' turns off the BOD in relevant sleep modes, while a zero in this bit keeps BOD active. The
default setting, BODS=0, keeps BOD active.

Note:  Writing to the BODS bit is controlled by a timed sequence and an enable bit.
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5. Updated Features

5.1 Signature Bytes
All AVR microcontrollers have a three-byte signature code, which identifies the device. This code can be
read in both serial and parallel mode, also when the device is locked. The three bytes reside in a
separate address space. For the device signature bytes, there are differences between
ATmega48/88/168 and ATmega48PB/88PB/168PB, see the table below for more detail.

Table 5-1. Device ID

Part Signature Bytes Address

0x000 0x001 0x002

ATmega48/V 0x1E 0x92 0x05

ATmega48PB 0x1E 0x92 0x10

ATmega88/V 0x1E 0x93 0x0A

ATmega88PB 0x1E 0x93 0x16

ATmega168/V 0x1E 0x94 0x06

ATmega168PB 0x1E 0x94 0x15

5.2 Full Swing Oscillator
The ATmega48/88/168 device includes a full swing crystal oscillator as a clock source option, which can
be selected by configuring the flash fuse. In the new ATmega48PB/88PB/168PB, the full swing crystal
oscillator is removed. Refer to the "Clock Sources" chapter in the device data sheet.

Table 5-2. Full Swing Oscillator Removed from ATmega48PB/88PB/168PB

Device Function ATmega48/88/168 ATmega48PB/88PB/168PB

Full swing crystal oscillator Yes No

5.3 Characteristics
This chapter will compare the biggest changes in electrical- and typical characteristics. For the most up-
to-date- and other numbers refer to the latest data sheet of the device.

The latest data sheets can be found here:
• ATmega48PB/88PB/168PB - http://www.microchip.com/wwwproducts/en/ATmega168pb
• ATmega48/88/168 - http://www.microchip.com/wwwproducts/en/ATmega168
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Table 5-3. Parallel Programming Characteristics

Symbol Parameter ATmega48/88/168 ATmega48PB/88PB/168PB Units

Min. Max. Min. Max.

tWLRH WR Low to
RDY/BSY
High

3.7 4.5 3.2 3.4 ms

tWLRH_CE WR Low to
RDY/BSY
High for Chip
Erase

7.5 9 9.8 10.5 ms

tBVDV BS1 Valid to
DATA valid

0 250 0 350 ns

tOLDV OE Low to
DATA Valid

0 250 0 350 ns

Table 5-4. Typical Wait Delay Before Writing the Next Flash or EEPROM Location

Symbol ATmega48/88/168 ATmega48PB/88PB/168PB Units

tWD_FLASH 4.5 2.6 ms

tWD_EEPROM 3.6 3.6 ms

tWD_ERASE 9.0 10.5 ms

tWD_FUSE - 4.5 ms
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6. Additional reading and related documents
• AVR095: Migrating between ATmega48, ATmega88 and ATmega168
• AVR512: Migration from ATmega48/88/168 to ATmega48P/88P/168P
• AVR528: Migrating from ATmega48P/88P/168P to ATmega48PA/88P/168PA
• AVR532: Migrating from ATmega48/88/168 to ATmega48A/88A/168A

• AN2519: AVR Microcontroller Hardware Design Considerations
• AT12615: Getting Started with ATmega48PB/88PB/ 168PB
• AVR040: EMC Design Considerations
• AVR053: Calibration of the internal RC oscillator
• AVR140: ATmega48/88/168 family run-time calibration of the Internal RC oscillator for LIN

applications
• AVR910: In-System Programming
• AVR4013: picoPower Basics
• AVR4100: Selecting and testing 32kHz crystal oscillators for AVR microcontrollers
• AVR42787: AVR Software User Guide

Additional documents can be found here: http://www.microchip.com/wwwproducts/en/ATmega168pb

Or our webpage at www.microchip.com
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http://ww1.microchip.com/downloads/en/appnotes/doc2554.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8035.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8196.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8280.pdf
http://ww1.microchip.com/downloads/en/AppNotes/00002519A.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-42422-mcu-getting-started-with-atmega168pb-at12615_application-note.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-1619-emc-design-considerations_applicationnote_avr040.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-2555-internal-rc-oscillator-calibration-for-tinyavr-and-megaavr-devices_applicationnote_avr053.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc7653.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc7653.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-0943-in-system-programming_applicationnote_avr910.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8349.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8333.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-42787-avr-software-user-guide_applicationnote_avr42787.pdf
http://www.microchip.com/wwwproducts/en/ATmega168pb
http://www.microchip.com
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The Microchip Web Site

Microchip provides online support via our web site at http://www.microchip.com/. This web site is used as
a means to make files and information easily available to customers. Accessible by using your favorite
Internet browser, the web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQ), technical support requests,
online discussion groups, Microchip consultant program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Customer Change Notification Service

Microchip’s customer notification service helps keep customers current on Microchip products.
Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata
related to a specified product family or development tool of interest.

To register, access the Microchip web site at http://www.microchip.com/. Under “Support”, click on
“Customer Change Notification” and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support.
Local sales offices are also available to help customers. A listing of sales offices and locations is included
in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is one of the most secure families of its kind on the

market today, when used in the intended manner and under normal conditions.
• There are dishonest and possibly illegal methods used to breach the code protection feature. All of

these methods, to our knowledge, require using the Microchip products in a manner outside the
operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is
engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.
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• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their
code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the
code protection features of our products. Attempts to break Microchip’s code protection feature may be a
violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software
or other copyrighted work, you may have a right to sue for relief under that Act.

Legal Notice

Information contained in this publication regarding device applications and the like is provided only for
your convenience and may be superseded by updates. It is your responsibility to ensure that your
application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS
CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE.
Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life
support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend,
indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BeaconThings,
BitCloud, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq, KeeLoq logo,
Kleer, LANCheck, LINK MD, maXStylus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB,
OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, Prochip Designer, QTouch, RightTouch, SAM-BA,
SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of
Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight
Load, IntelliMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip
Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, BodyCom,
chipKIT, chipKIT logo, CodeGuard, CryptoAuthentication, CryptoCompanion, CryptoController,
dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, EtherGREEN, In-Circuit Serial
Programming, ICSP, Inter-Chip Connectivity, JitterBlocker, KleerNet, KleerNet logo, Mindi, MiWi,
motorBench, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient
Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, PureSilicon, QMatrix, RightTouch logo, REAL
ICE, Ripple Blocker, SAM-ICE, Serial Quad I/O, SMART-I.S., SQI, SuperSwitcher, SuperSwitcher II, Total
Endurance, TSHARC, USBCheck, VariSense, ViewSpan, WiperLock, Wireless DNA, and ZENA are
trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of
Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
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ISBN: 978-1-5224-2460-4

Quality Management System Certified by DNV

ISO/TS 16949
Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer
fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California
and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC®

DSCs, KEELOQ® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and
analog products. In addition, Microchip’s quality system for the design and manufacture of development
systems is ISO 9001:2000 certified.
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AMERICAS ASIA/PACIFIC ASIA/PACIFIC EUROPE
Corporate Office
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200
Fax: 480-792-7277
Technical Support:
http://www.microchip.com/
support
Web Address:
www.microchip.com
Atlanta
Duluth, GA
Tel: 678-957-9614
Fax: 678-957-1455
Austin, TX
Tel: 512-257-3370
Boston
Westborough, MA
Tel: 774-760-0087
Fax: 774-760-0088
Chicago
Itasca, IL
Tel: 630-285-0071
Fax: 630-285-0075
Dallas
Addison, TX
Tel: 972-818-7423
Fax: 972-818-2924
Detroit
Novi, MI
Tel: 248-848-4000
Houston, TX
Tel: 281-894-5983
Indianapolis
Noblesville, IN
Tel: 317-773-8323
Fax: 317-773-5453
Tel: 317-536-2380
Los Angeles
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608
Tel: 951-273-7800
Raleigh, NC
Tel: 919-844-7510
New York, NY
Tel: 631-435-6000
San Jose, CA
Tel: 408-735-9110
Tel: 408-436-4270
Canada - Toronto
Tel: 905-695-1980
Fax: 905-695-2078

Australia - Sydney
Tel: 61-2-9868-6733
China - Beijing
Tel: 86-10-8569-7000
China - Chengdu
Tel: 86-28-8665-5511
China - Chongqing
Tel: 86-23-8980-9588
China - Dongguan
Tel: 86-769-8702-9880
China - Guangzhou
Tel: 86-20-8755-8029
China - Hangzhou
Tel: 86-571-8792-8115
China - Hong Kong SAR
Tel: 852-2943-5100
China - Nanjing
Tel: 86-25-8473-2460
China - Qingdao
Tel: 86-532-8502-7355
China - Shanghai
Tel: 86-21-3326-8000
China - Shenyang
Tel: 86-24-2334-2829
China - Shenzhen
Tel: 86-755-8864-2200
China - Suzhou
Tel: 86-186-6233-1526
China - Wuhan
Tel: 86-27-5980-5300
China - Xian
Tel: 86-29-8833-7252
China - Xiamen
Tel: 86-592-2388138
China - Zhuhai
Tel: 86-756-3210040

India - Bangalore
Tel: 91-80-3090-4444
India - New Delhi
Tel: 91-11-4160-8631
India - Pune
Tel: 91-20-4121-0141
Japan - Osaka
Tel: 81-6-6152-7160
Japan - Tokyo
Tel: 81-3-6880- 3770
Korea - Daegu
Tel: 82-53-744-4301
Korea - Seoul
Tel: 82-2-554-7200
Malaysia - Kuala Lumpur
Tel: 60-3-7651-7906
Malaysia - Penang
Tel: 60-4-227-8870
Philippines - Manila
Tel: 63-2-634-9065
Singapore
Tel: 65-6334-8870
Taiwan - Hsin Chu
Tel: 886-3-577-8366
Taiwan - Kaohsiung
Tel: 886-7-213-7830
Taiwan - Taipei
Tel: 886-2-2508-8600
Thailand - Bangkok
Tel: 66-2-694-1351
Vietnam - Ho Chi Minh
Tel: 84-28-5448-2100

Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4450-2828
Fax: 45-4485-2829
Finland - Espoo
Tel: 358-9-4520-820
France - Paris
Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79
Germany - Garching
Tel: 49-8931-9700
Germany - Haan
Tel: 49-2129-3766400
Germany - Heilbronn
Tel: 49-7131-67-3636
Germany - Karlsruhe
Tel: 49-721-625370
Germany - Munich
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44
Germany - Rosenheim
Tel: 49-8031-354-560
Israel - Ra’anana
Tel: 972-9-744-7705
Italy - Milan
Tel: 39-0331-742611
Fax: 39-0331-466781
Italy - Padova
Tel: 39-049-7625286
Netherlands - Drunen
Tel: 31-416-690399
Fax: 31-416-690340
Norway - Trondheim
Tel: 47-7289-7561
Poland - Warsaw
Tel: 48-22-3325737
Romania - Bucharest
Tel: 40-21-407-87-50
Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
Sweden - Gothenberg
Tel: 46-31-704-60-40
Sweden - Stockholm
Tel: 46-8-5090-4654
UK - Wokingham
Tel: 44-118-921-5800
Fax: 44-118-921-5820

Worldwide Sales and Service
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